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Warranty 

All products manufactured by ICP DAS are under warranty 

regarding defective materials for a period of one year, beginning 

from the date of delivery to the original purchaser. 

Warning 

ICP DAS assumes no liability for any damage resulting from the 

use of this product. ICP DAS reserves the right to change this 

manual at any time without notice. The information furnished by 

ICP DAS is believed to be accurate and reliable. However, no 

responsibility is assumed by ICP DAS for its use, not for any 

infringements of patents or other rights of third parties resulting 

from its use. 

Copyright 

Copyright @ 2012 by ICP DAS Co., Ltd. All rights are reserved. 

Trademark 

The names used for identification only may be registered 

trademarks of their respective companies. 

 

Contact US 

 

If you have any problem, please feel free to contact us. 

You can count on us for quick response. 

 

   Email: service@icpdas.com 

  

mailto:service@icpdas.com
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1. Introduction 

 

ViewPAC combines WinPAC, graphic display and keypad in one unit. It equips a PXA270 

CPU (520 MHz) running Windows CE.NET 5.0 operating system, various connectivity 

(USB, Ethernet, RS-232/485), 3 slots to expand I/O modules, 3.5”/5.7” TFT LCD and a 

rubber keypad. 

 

Its operating system, Windows CE.NET 5.0, has many advantages, includes hard 

real-time capability, small core size, fast boot speed, interrupt handling at a deeper level, 

achievable deterministic control and low cost. Running Windows CE.NET 5.0 in the 

ViewPAC gives it the ability to run PC-based control software such as Visual Basic.NET, 

Visual C#, Embedded Visual C++, SCADA software, Soft PLC …etc. 

 

Compared with traditional IPC + PLC solutions, ViewPAC reduces overall system cost, 

space and gives you all the best features of IPC and PLC 
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1.1. Features 

The ViewPAC offers the most comprehensive configuration and remote system upgrade 

solutions to meet specific application requirements. The following list shows the 

hardware and software features designed to simplify installation, configuration and 

application. 

Software Features 

 Windows CE .Net 5.0 Inside 

 Easy Remote Maintenance via Ethernet 

1. FTP Server 

2. VCEP Software 

 Built-In OPC Server: NAPOPC_CE5 

1. An OPC Server for SCADA Software 

2. Integrates Local/Remote I/O Modules via RS-232/485 or Ethernet 

3. Provides Library for eVC, C#, or VB.NET 

4. Supports Modbus and DCON Protocols 

 Development Software 

Visual Studio.NET 2005/2008, and eVC 

 SDK/Demo Programs for C#, VB.NET & eVC 
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Hardware Features 

 PXA 270 CPU (32-bit & 520 MHz) 

 IP65 Compliant Front Panel 

 3.5”/5.7” TFT LCD (5.7” LCD is with Touch Panel) 

 Rubber Keypad with 24/6 Keys 

 Audio with MIC-In and Line-Out 

 64-bit Hardware Serial Number for Software Protection 

 3 Slots for High Profile I/O Modules 

 Rich I/O Expansion Ability 

1. Ethernet 

2. RS-232/422/485 

3. FRnet 

4. CAN bus 

 Dual Battery Backup SRAM (512 KB) 

 One Ethernet Port 

 2 Serial Ports (RS-232, RS-485) 

 Operating Temperature: -20 ~ +70 °C 
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1.2. Specifications 

The table below summarizes the specifications of the ViewPAC. 

 

System Software VP-23W1 VP-25W1 

OS Windows CE .NET 5.0 

.Net Compact Framework 2.0 

Embedded Service FTP server, Web server (supports VB script, JAVA 

script), Embedded SQL server 

SDK Provided Dll for eVC, Dll for Visual Studio.Net 2005/2008 

 

CPU Module VP-23W1 VP-25W1 

CPU PXA270 or compatible (32-bit and 520 MHz) 

SDRAM 128 MB 

Dual Battery Backup SRAM 512 KB (for 5 years data retention) 

Flash 96 MB (64 MB for OS image, 31 MB for built-in Flash 

disk, 1 MB for registry) 

EEPROM 16 KB (data retention: 40 years; 1,000,000 

erase/write cycles) 

Expansion Flash Memory microSD socket with one 1 GB microSD card (support 

up to 16 GB microSDHC card) 

RTC (Real Time Clock) Provide seconds, minutes, hours, date of 

week/month; month and year, valid from 1980 to 2079 

64-bit Hardware Serial 

Number 

Yes 

Dual Watchdog Timer Yes (0.8 second) 

Rotary Switch Yes (0 ~ 9) 

 

I/O Expansion Slots VP-23W1 VP-25W1 

Slot Number 3 (for high profile I-8K and I-87K modules only) 

Hot Swap *Will be available Yes (for high profile I-87K modules only) 
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Communication Interface VP-23W1 VP-25W1 

Ethernet Port RJ45 * 1, 10/100 Base-TX 

(Auto-negotiating, Auto MDI/MDIX, LED indicators) 

USB 1.1 (host) 1 

COM0 Internal communication with the high profile I-87K 

series modules in slots 

COM2 RS-485 (D2+, D2-; self-tuner ASIC inside);  

2500 VDC isolated 

COM3 RS-232 (RxD, TxD, CTS, RTS, DSR, DTR, CD, RI 

and GND); Non-isolated 

 

Main Machine Interface VP-23W1 VP-25W1 

LCD 3.5” TFT 

(Resolution 320 x 240) 

5.7” TFT 

(Resolution 640 x 480) 

Touch Panel - Yes 

Rubber Keypad 24 Keys 6 Keys 

Audio Microphone-In and Earphone-Out 

LED Indicators 3 Dual-Color LEDs (PWR, RUN, LAN1, L1, L2, L3; L1 

~ L3 for user programmable) 

 

Environmental VP-23W1 VP-25W1 

Operating Temperature -20 ~ +70 °C 

Storage Temperature -30 ~ +80 °C 

Ambient Relative Humidity 5 ~ 90% RH, non-condensing 

 

Power VP-23W1 VP-25W1 

Input Range +10 V ~ +30 VDC 

Isolation 1 kV 

Capacity 2.5 A, 5 V supply to I/O expansion slots 

Consumption 7.2 W (0.3 A @ 24 VDC) 

 

Mechanical VP-23W1 VP-25W1 

Dimension (W x D x H) 182 mm x 158 mm x 125 mm 

Ingress Protection Front panel: IP65 

Installation Panel mounting 
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1.3. Overview 

The ViewPAC contains several interfaces and peripherals that can be integrated with 

external systems. Here is an overview of the components and its descriptions. The 

details of these items are as follows: 
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1. LED Indicators 

The ViewPAC contains three LED indicators that are located on the top of the unit. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The LED indicators can be used to indicate the power status, OS status and Link/Activity, 

and are described as follows: 

 

LED Indicator State (Color) Meaning 

L1/L2/L3 ON (Red) Controlled via a program 

 OFF Controlled via a program 

RUN ON (Green) The OS is on 

 Blink 
The System_disk is being formatted or 

defragmented 

PWR ON (Green) The Power is ON 

 OFF The Power is OFF 

LAN1 ON (Green) The Link is active 

 OFF The Link is inactive 

 Blink (Green) Network activity 
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2. LCM 

The LCM size of the VP-23W1 is 3.5” 320 x 240. 

The LCM size of the VP-25W1 is 5.7” 640 x 480. 

3. Keypad 

The keypad on the VP-2000 is used to provide support for keyboard input. 

The F1 ~ F6 function keys can also be programmed by the user. 

4. Micro SD Socket 

The ViewPAC also contains a Micro SD socket that can be used to increase memory 

capacity to 16 GB. 

5. Rotary Switch 

The Rotary Switch is an operating mode selector switch which provides 

seven functions related to the selection of the operating mode and 

authorization control for the VP-2000. 

For more information about the operating mode, please refer to “section 

2.2. Configuring the Boot Mode” 

6. I/O Expansion Slots 

The VP-2000 contains three I/O expansion slots that are used to serve in the local and 

remote expansion.  

 

 



 

VP-23W1/VP-25W1 User Manual, version 1.0.7.   Last Revised: March 2012   Page: 15 

Copyright ©  2012 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 

 

 

7. Power Input and Frame Ground 

The VP-2000 contains a power terminal that is used to 

provide power for its operation.  

The terminal block contains 3 pins and the pin assignments 

are as follows: 

8. Waterproof Ethernet Port 

The VP-2000 contains an Ethernet port that is waterproof to protect the device from 

external contaminants. 

9. COM2 (RS-485) 

The COM2 port provides a connection to external RS-485 

devices. The COM2 has 2 pins, as follows: 

10. COM3 (RS-232) 

Port Type: Male 

Baud Rate: 115200, 57600, 38400, 19200, 

9600, 4800, 2400, 1200 bps 

Data Bits: 5, 6, 7, 8 

Parity: None, Even, Odd, Mark (Always 1), Space 

(Always 0) 

Stop Bits: 1, 2 

FIFO: 16 bytes 

 

 

 

 



 

VP-23W1/VP-25W1 User Manual, version 1.0.7.   Last Revised: March 2012   Page: 16 

Copyright ©  2012 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 

 

 

Tips & Warnings 

The table below shows the data bit of each COM port and their 

corresponding stop bit. 

Word Length Number of Stop Bits 

5, 6, 7, 8 1 

5 1.5 

6, 7, 8 2 

 

 

 

11. USB Port 

The VP-2000 contains a USB port that allows support for USB devices such as mouse, 

keyboard or an external USB hard drive.  

12. Microphone and Earphone Jacks 

The VP-2000 contains a microphone and an earphone jack to allow the input and output 

of audio system. 
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1.4. Dimensions 

The diagrams below provide the dimensions of the standard VP-2000 family to use in 

defining your enclosure specifications. Remember to leave room for potential expansion 

if you are using other components in your system. 

All dimensions in millimeter. 

VP-23W1 
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1.5. Companion CD 

This section describes the content of the companion CD, which provides the resource, 

tool kit, software and documentation related to the ViewPAC. 

 

 

CD:\Napdos 

vp-2000_ce50 

backup 

The backup files related to the documents, OS images, 
SDKs...., etc. 

Demo 

The demo programs for examples of use in the application. 

Document 

The technical support documents for installation, operation, 

maintenance, development and application. 

Micro_SD 

The tools and drivers related to manage the ViewPAC 

OS_image 

The files and related information for OS releases and 
technology. 

PC_Tools 

The tools and utilies for operation with PC. 

SDK 

The sources for development and application in your 
application. 

System_Disk 

The tools and drivers related to System_Disk that install  on 
ViewPAC  

Update 

The installation packages related to ViewPAC 
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2. Getting Started 

This chapter provides a guided tour that describes the steps needed to download, install, 

configure, and run the basic procedures for user working with the ViewPAC for the first 

time. 

 

Before starting any task, please check the package contents. If any of the following 

package contents are missing or damaged, contact your dealer, or distributor. 

 

In addition to this guide, the package includes the following items: 

 

 

 

 

 

VP-23W1/VP-25W1 & Touch Pen     Expansion I/O Socket * 3 

 

 

 

 

 

Quick Start Guide   Software Utility CD  1 GB Micro SD Card 

 

 

 

 

 

RJ-45 Waterproofing Kit  Panel Clip * 4   Screw Driver 

 



 

VP-23W1/VP-25W1 User Manual, version 1.0.7.   Last Revised: March 2012   Page: 21 

Copyright ©  2012 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 

 

 

2.1. Mounting the Hardware 

Before you work with the ViewPAC, you should have a basic understanding of hardware 

specification, such as the dimensions, the usable input-voltage range of the power supply, 

and the type of communication interfaces. 

 

For more information about the hardware details, see section 1.2., “Specifications.” 

For more information about the hardware dimensions, see section 1.4., “Dimension.” 

 

 

2.1.1. Removing the Slot Cover 

The ViewPAC has a slot cover to protect the internal 

components from damage during shipping. Before 

starting any installation, please first remove the slot 

cover. 

 

 

 

 

 

 

Step 1: Hold the top of ViewPAC 

 

Step 2: Pull the plastic wrap 

 

 

 

 

 

 

The slot cover has 

been removed 
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2.1.2. Installing Expansion I/O Sockets 

The case (a socket and a top case) is included in the package. Before inserting the I/O 

modules talling the I/O modules in  

If you do not expand the I/O module full, please keep the 

top case of the unused slot to protect the backplane from 

dirt, dust and damage from foreign objects. 

 

 

 

 

 

Step 1: Take the socket out from the case 

 

 

Step 2: Padlock the bottom of 

the socket into the 

ViewPAC 

 

 

Step 2: Slide the socket into the ViewPAC 

until it clicks 
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2.1.3. Installing the I/O Modules 

ViewPAC supports various types of I/O expansion modules for interfacing many different 

field devices. 

For more information about I/O expansion modules, please refer to: 

http://www.icpdas.com/products/PAC/winpac/io_support_list.htm 

 

 

Step 1: Hold the I/O module vertically and align 

the socket 

 

Step 2: Carefully press the I/O module onto the 

socket 

 

 

Tips & Warnings 

If you do not expand the I/O module full, please keep the top case of the 

unused slot to protect the backplane from dirt, dust and damage from 

foreign objects. 

 

 

 

Step 3: Read the relevant documentation 

 

For high profile I-8K series:  

CD:\ Napdos\io_module 

http://www.icpdas.com/products/PAC/winpac/io_support_list.htm 

 

For high profile I-87K series:  

CD:\ Napdos\io_module 

http://www.icpdas.com/products/PAC/winpac/io_support_list.htm 

http://www.icpdas.com/products/PAC/winpac/io_support_list.htm
http://www.icpdas.com/products/PAC/winpac/io_support_list.htm
http://www.icpdas.com/products/PAC/winpac/io_support_list.htm
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Step 4 Wire the I/O channels 

All documents include the I/O module specifications, pin assignments and wiring 

connections. 

 

For example, Pin Assignments and Wiring connections for the I-87054W module are as 

follows: 

 

 

 

 

 

Tips & Warnings 

It is recommended that the power to the ViewPAC is switched off when 

wring the I/O module which are plugging in the ViewPAC slots. 
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2.1.4. Mounting the Waterproof 

The ViewPAC provides an IP67 waterproof connector to ch consists of the following 

components plugged in RJ-45 cable. 
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2.1.5. Mounting the ViewPAC 

The ViewPAC can be mounted on a panel of maximum 

thickness 12 mm. Adequate access space can be available 

at the rear of the instrument panel for wiring and servicing 

purposes. 

 

Tips & Warnings 

To ensure proper ventilation for your 

ViewPAC, leave a minimum of 50mm 

space between the top and bottom edges 

of the ViewPAC and the enclosure panels. 

 

 

 

Step 1: Prepare the panel and cut the hole 

to the specified size 

 

Step 2: Attach the ViewPAC to the cut-out 

hole 
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Step 3: Insert the panel mounting clips into the upper and lower ventilation 

holes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4: Screw the panel 

mounting clips to the 

panel 
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2.1.6. Deploying a Basic ViewPAC Application 

The ViewPAC provides a variety of communication interface to suit a range of applications. 

Here is a simple application for using the ViewPAC that is shown below. 

 

Step 1: Connect the positive terminal (+) of the power supply to the terminal 

PWR and the negative terminal (-) of the power supply to the P.GND 

Tips & Warnings 

The input range of power supply is +10 ~ +30 VDC 

 

 

Step 2: Connect PC to the Ethernet port 

Step 3: Connect the USB keyboard to the USB port 

Step 4: Connect the audio to the microphone and earphone jack 
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2.2. Configuring the Boot Mode 

The ViewPAC has five operating modes that can be determined through a rotary switch. 

 

The table below lists the operation mode selection. 

 

 Rotary switch position Modes of operation 

0 Normal mode (Default) 

1 Safe mode 

2 Debug mode 

3 OS update mode 

4 Development mode 

5 DCON_CE 

6 VCEP 

7 ~ 9 (For user) 

 

Normal Mode (Default) 

Normal mode is the default mode of operation and the one you will use most of the time. 

Use this mode for more tasks and configurations. Programs also are executed in this 

mode. 

Safe Mode 

Safe mode is a trouble shooting. The mode loads the minimum required device drivers 

and system services to boot the ViewPAC. 
 

If you have malicious software or a program caused the ViewPAC cannot be boot or run 

the normal mode, you can boot in safe mode to solve the problem. 
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Tips & Warnings 

n normal mode, if the new settings are not saved when you change and 

save the settings using the ViewPAC Utility, to solve this problem, 

perform the following steps: 
 

Step 1: Restart the ViewPAC in safe mode 
 

Turn the rotary switch to “1”, and then restart the ViewPAC. 

 

 

 

Step 2: Start the ViewPAC Utility to restore 

the default settings 
 

Start the ViewPAC Utility, and then click the 

“Restore Default Settings” command and “Save” 

command from the “File” menu 

 
 

 

 

Step 3: Restart the ViewPAC in 

normal mode 
 

Turn the rotary switch to “0”, and then 

restart the ViewPAC. 
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Debug Mode 

Debug mode is a special environment in which program debug functions can be used in 

addition to normal system functions. 

Debug mode is unsupported. 

OS Update Mode 

OS update mode is a way used to update OS. To update the ViewPAC OS image, please 

refer to “6.1. OS updates” 

DCON_CE Mode 

This mode is the same as Normal mode. Besides, DCON_CE.exe will be run 

automatically after booting 

 

 

Tips & Warnings 

DCON_CE.exe must be placed on the \System_Disk\Tools\DCON_CE, 

or else DCON_CE.exe cannot be run automatically after booting. 

 

 

 

VCEP Mode 

This mode is the same as Normal mode. Besides, VCEP.exe will be run automatically 

after booting. 
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Tips & Warnings 

VCEP.exe must be placed on the \System_Disk\Tools\VCEP or 

else VCEP.exe cannot be run automatically after booting. 

 

 

 

User Mode 

Rotary switch position 7, 8, 9 are reserved for user’s applications. 

When ViewPAC is boot with one of these rotary switch positions, it is boot at normal 

mode. User’s application can check the rotary switch position to run at different mode. 
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2.3. Testing the ViewPAC 

VP-23W1: 

ViewPAC combines WinPAC, graphic display and keypad dial in one unit. The ViewPAC 

Quick Test is a toolkit used to check out the ViewPAC particular function compared with 

WinPAC. 

 

Audio Options: 

 

 

Play Audio button is used to check the audio 

output. 

 

Buzzer Options: 

 

 

Play Buzzer button is used to check the buzzer. 

 

LED Options: 

These buttons are used to 

check LEDs sign. 

 

KeyPAD Option: 

Checkboxes are used to check 

the KeyPAD. 
 

Text field is used to check the 

input format. 

 

 

Tips & Warnings 

The shift key is a modifier key used to enter alternate upper letters or 

characters. 
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VP-25W1: 

ViewPAC combines WinPAC, graphic display and keypad dial in one unit. The ViewPAC 

Quick Test is a toolkit used to check out the ViewPAC particular function compared with 

WinPAC. 

 

Audio Options: 

 

 

Play Audio button is used to check the 

audio output. 

 

Buzzer Options: 

 

 

Play Buzzer button is used to check the 

buzzer. 

 

 

LED Options: 

These buttons are used to 

check LEDs sign. 

 

KeyPAD Option: 

Checkboxes are used to check 

the KeyPAD. 

 

LCD Backlight Options: 

The slider is used to check the 

LCD Backlight. 
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2.4. Using ViewPAC Utility to manage the ViewPAC 

The ViewPAC Utility is a toolkit used to quickly control and manage the ViewPAC. 

 

For more detailed information on ViewPAC Utility applications, please refer to 

“3.5. ViewPAC Utility” 

 

Step 1: Run the ViewPAC Utility located on desktop 

 

 

 

 

Step 2: Configure IP address (DHCP), 

FTP Server, Auto Execution 

files…, etc 

 

 

 

 

 

 

Step 3: Save and Reboot the 

ViewPAC 
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2.5. Using DCON Utility to Configure the I/O Modules 

DCON Utility is a tool kit used to quickly control and manage expansion I/O modules with 

DCON protocol. 

 

 

Step 1: Run the DCON firmware on the ViewPAC controller 
 

The DCON firmware is located at: 

\System_Disk\tools\DCON_CE\ 

 

 

 

 

 

 

 

Step 2: Run the DCON Utility on the host PC 
 

The DCON Utility can be obtained from: 

CD:\Napdos\vp-2000_ce50\PC_Tools\DCON_Utility\ 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/pc_tools/dcon_utility/ 

 

 

Step 3: Click the WIN CE button 

 

 

 

 

 

 

 

 

 

 

 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/pc_tools/dcon_utility/
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Step 4: On the WINCE device connection, enter the IP address of the 

ViewPAC to search the I-87K series expansion I/O modules 

 

 

 

 

 

 

 

 

 

 

Step 5: It will display a list of I-87K series expansion I/O modules, then select 

the module name that you want to configure 
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2.6. Using Backup Utility to back up the settings and files 

After saving the configuration settings for a ViewPAC device following the first use, it is 

recommended to use the Backup utility to back up all the data (settings and files). 

 

 

Step 1: Run the Backup Utility on the ViewPAC 
 

The DCON firmware is located at: 

\System_Disk\tools\Backup_utility\ 

 

 

 

 

 

 

 

 

 

 

Step 2: Click the Backup menu 

 

 

 

 

 

 

 

Step 3: Select the options that 

you want to backup, 

enter text annotations 

and then click the Start 

backup button 

 



 

VP-23W1/VP-25W1 User Manual, version 1.0.7.   Last Revised: March 2012   Page: 40 

Copyright ©  2012 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 

 

 

 

 

Step 4: Confirm the backup 

options and then click 

Yes button 

 

 

 

 

 

 

Step 5: Choose the folder that you 

want to save backup file and 

click the Ok button 

 

 

 

 

 

 

 

 

Step 6: Wait for process to 

finish 
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2.7. A caution about using System_Disk 

The System_disk is an authoritative storage device, but is not suitable for frequent 

copying and deleting of files and is only suitable for storing important files that are not 

changed frequently. 

If files are copied and deleted frequently, the system will automatically perform a 

System_Disk defragment action, which will consume the total resources of the CPU and 

cause the OS not to function correctly. 

When the OS System_Disk defragment action is being performed, the run LED will blink 

and the defragment action icon will show in the system tray in the bottom right-hand of 

the pc screen. 

Note: Do not power off the WinPAC while the defragment is being performed. 

 

Tips & Warnings 

Don not power off the WinPAC while the defragment is being 

performed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 



 

VP-23W1/VP-25W1 User Manual, version 1.0.7.   Last Revised: March 2012   Page: 42 

Copyright ©  2012 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 

 

 

3. Tools and Tasks 

This chapter briefly describes the functions of the ViewPAC software toolkits. 

 

Following tools has been installed on the ViewPAC. 

 

CD:\Napdos 

vp-2000_ce50 

System_Disk 

Tools 

Backup_Utility 

Dcomcnfg 

DCON_CE 

DCON_Utility_CE5 

ISQLW35 

Modbus 

modbus_master_tool 

NAPOPC_CE5 

RegistryEditor 

RegistryViewer 

Remote_display_application 

SendToCOM 

TaskMgr 

VCEP 

ViewPAC_Utility 
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 DCON_CE 

With Host PC running the DCON Utility, on the ViewPAC, the DCON_CE program 

allows user to view and monitor the status of the DCON Utility. 

 ISQLW35 

The ISQLW35 implements SQL server compact 3.5 Query Analyzer. 

 Modbus 

The Modbus provides various applications of Modbus protocol for configuring the 

ViewPAC. 

 NAPOPC_CE5 

NAPOPC_CE5 is an integrated omnibus software package, it allows user to quickly 

establish a DCS control system. 

For more information about the NAPOPC_CE5, please refer to “3.2. NAPOPC_CE5”. 

 RegistryViewer 

The Registry Viewer allows user to view the registry value of Windows CE Operating 

System. 

 Remote display application  

The remote display application allows user to view the display remotely of the 

ViewPAC on a Host PC. 

 SendToCOM 

The SendToCOM allows user to send/receive data to/from the expansion module via 

serial port. 
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 TaskMgr 

The TaskMgr provides details about programs and processes running on the 

ViewPAC. 

 VCEP 

The VCEP allows user to manage the ViewPAC remotely on a Host PC. 

For more information about the VCEP, please refer to “3.4. VCEP (Virtual CE Pro)”. 

 ViewPAC Utility 

 

The ViewPAC Utility provides various useful functions such as configuring Ethernet 

settings, monitoring system settings and FTP services .etc for easy and quick 

management. 

For more information about the ViewPAC Utility, please refer to “3.5. ViewPAC Utility”. 
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3.1. DCON Utility 

 

The DCON Utility is a tool kit that help user search the network, easily to Configure the 

I/O modules and test the I/O status via the serial port (RS-232/485) or Ethernet port 

(using virtual com port). It supports not only the DCON Protocol I/O modules but also the 

M Series I/O Modules (Modbus RTU M-7K, M-87K and will support Modbus ASCII M-87K) 

now. 

 

 

For more detailed information on ViewPAC Utility applications, please refer to 

“2.5. Using DCON Utility to configure the I/O modules” 
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3.2. NAPOPC_CE5 

NAPOPC_CE5 DA Server is a free OPC DA Server (The "OPC" 

stands for "OLE for Process Control" and the "DA" stands for " Data 

Access") working on WinPAC, ViewPAC & WinCon controllers 

provided by ICP DAS Ltd. The first standard (originally called simply 

the OPC Specification and now called the Data Access Specification) 

resulted from the collaboration of a number of leading worldwide automation suppliers 

working in cooperation with Microsoft. Originally based on Microsoft's OLE COM 

(component object model) and DCOM (distributed component object model) 

technologies, the specification defined a standard set of objects, interfaces and methods 

for use in process control and manufacturing automation applications to facilitate 

interoperability. NAPOPC_CE5 DA Server integrates OPC, Modbus TCP Slave and 

Modbus RTU Slave three kind Slave services, as well as integrates Modbus TCP Master, 

Modbus RTU Master and DCON three kind Master communication protocols. It also 

provides one advanced function “Rule Script” for use in the I/O integration and 

transformation, and some conditional Logic operation. 

 

Any version before 2.1.0 of the NAPOPC_CE5 was named “Quicker” 
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3.3. SendToCOM 

The SendToCOM uses the serial port to communicate with expansion module. To use the 

SendToCOM, you can send data to expansion module through the serial port, and 

receive data from other device through the serial port. 

 

For more information about these commands for communicating with expansion module, 

please refer to: 

CD:\Napdos\io_module\87k_high_profile_modules.htm 
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3.4. VCEP 

ICPDAS VCEP is designed 

for managing your 

ViewPAC anywhere. No 

matter where you are, 

ICPDAS VCEP provides a 

convenient environment on 

the Desktop PC and allows 

you control your ViewPAC 

remotely. 

 

ICPDAS VCEP is composed of two main components: 

The “Server” which runs on ViewPAC. 

The “Client" which runs on a Desktop PC. 

 

Once a connection is established between the client and server (initiated by the client), 

the client will periodically send requests for screen updates and send mouse/key click 

information to the server to simulate. Each video frame is inter-compressed against the 

previous frame and then intra-compressed with a modified LZW scheme to minimize the 

amount of data transmitted from server to client. 

 

For more detailed information on VCEP application, please refer to 

http://www.icpdas.com/products/PAC/wincon-8000/wincon_VirtualCE.htm 

 

http://www.icpdas.com/products/PAC/wincon-8000/wincon_VirtualCE.htm
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3.5. ViewPAC Utility 

The ViewPAC Utility is a tool which is designed to quickly control and management the 

ViewPAC. 
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3.5.1. Menu Bar 

 

The ViewPAC Utility includes the following function menu. All function menus will be 

explained later. 

 

 

 File Menu 

 

 

 

 Help Menu 

 

 

 

 Configuration Menu 
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File Menu 

 

 

 

 

 

The menu commands Use to 

Save Saves the settings into Flash. 

The new settings don’t take effect until the ViewPAC 

restart. 

Save and Reboot Saves the settings into Flash and restart the 

ViewPAC. 

The new settings will take effect after the ViewPAC 

restart. 

Reboot Without Save Restarts the ViewPAC without save the settings into 

Flash. 

Restore Default Settings Restarts the settings of ViewPAC to its factory 

default values. 

The settings include configuration setting, network 

setting, auto execution, etc. 

Exit Exits the ViewPAC Utility. 
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Help Menu 

 

 

 

 

The menu commands Use to 

Reset System to Default Resets the system interrupt status to default. 

The operation used in the situation when the 

interrupt crash. 

You can select this operation to reset the interrupt 

status without rebooting the device. 

Release Notes Checks out what’s new and the know issues. 

About Displays a dialog box with information about 

ViewPAC Utility, including the current version and 

copyright information. 
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Configuration Menu 

 

 

 

 

The menu commands Use to 

Import Registry Key Backs up a sub-key of registry by using a registration 

entry (.reg) file. 
 

How to use: 

Step 1: Select the “Import Registry Key”, then the 

“Open” dialog box will appear 

Step 2: On the “Open” dialog box, select a 

specific .reg file to import 
 

Warning: 

1. The .reg file which should be saved by “Export 

Registry Key”. 

2. It will not save automatically after import a .reg file. 

Export Registry Key Makes a back up of a registry sub-key 
 

How to use: 

Step 1: Select the “Export Registry Key”, then the 

“Export Registry” box will appear 

Step 2: Select a specific root key 

Step 3: Input a specific path of sub-key 

Step 4: Push the “OK” button, then the “Save As” 

dialog box will appear prompting you to select a 

location where you want to save this exported file 
 

Warning: 

The export operation will export all the sub-keys of 

the specific key which you input. 

Store All Registry 

Setting 

Stores all registry setting to flash from .das file which 

is saved by “Dump All Registry Setting”. 
 

How to use: 
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The menu commands Use to 

Step 1: Select the “Store All Registry Setting” , then 

the “Open” dialog box will appear 

Step 2: On the “Open” dialog box, select a 

specific .das file to store 
 

Warning: 

1. The .das file which should be saved by “Dump All 

Registry Setting”. 

2. It will save automatically after store .das file. 

Dump All Registry 

Settings 

Dump all registries setting to .das file. 
 

How to use: 

Select the “Dump All Registry Setting”, then the 

“Save As” dialog box will appear prompting you to 

select a location where you want to save this 

exported file. 
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3.5.2. Property Tabs 

 

The ViewPAC Utility includes the following property tabs, all property tabs will be 

explained later. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 System Setting 

 Ethernet Setting 

 Network Setting 

 System Information 

 Auto Execution 

 Multi-serial port wizard 

 System Memory Setting 

 Backplane Compatibility  
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System Setting Tab 

 

 

The System tab provides functions to configure the task bar HTTP directory path. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Adjust the size of the desktop Select a display resolution from the 

Resolution list. 

Lock or Auto-Hide the taskbar Auto-Hide:  

Select the Auto Hide check box 

Lock:  

Select the Always On Top check box. 

Check the status of the battery See the Battery1 and Battery2 field that 

displays the battery status. 

Change the HTTP directory path Enter a new path in the Change HTTP 

document root directory 

\windows\www\wwwsub to field, and 

then press the Setting button. 

  



 

VP-23W1/VP-25W1 User Manual, version 1.0.7.   Last Revised: March 2012   Page: 57 

Copyright ©  2012 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 

 

 

Ethernet Setting Tab 

 

 

The Ethernet Setting tab provides functions to configure either DHCP (Roaming) or 

manually configured (Static) network settings and to monitor the MAC address. 

Generally, DHCP is the default settings, but if you don’t have a DHCP server, you must 

configure the network settings by using manual configuration. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Configure the network 

settings 

Obtaining an IP address automatically from DHCP: 

Select the Use DHCP to get IP address option, and 

then press the Setting button. 

Manually assign an IP address: 

Select the Assign IP address option, and then press 

the Setting button. 

Monitor the MAC 

address 

See the MAC Address 1 fields that display the 

physical address of LAN1. 

Set up the i-8135 

Ethernet module driver 

See the next page. 
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8135 tab 

 

This tab provides functions to set up the i-8135 Ethernet module driver. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Set up the i-8135 network 

settings 

Obtaining an IP address automatically from 

DHCP: 

Select the Use DHCP to get IP address option, 

and then press the Setting button. 

Manually assign an IP address: 

Select the Assign IP address option, and then 

press the Setting button. 
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Network Setting Tab 

 

 

The Network tab consists of two tabs, Access and Login, which provides functions to 

enable/disable the FTP access, enable/disable anonymous FTP access, configure the 

FTP directory path, change HTTP document root directory and maintain the FTP 

accounts. 
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FTP Settings tab 

 

This tab provides functions to enable/disable the FTP access, enable/disable 

anonymous FTP access, and configure the FTP directory path. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Enable or disable 

the FTP access 

Enable: Select the Enable check box in the FTP field. 

Disable: Select the Disable check box in the FTP field. 

Enable or disable 

anonymous FTP 

access 

Enable: Select the Enable check box in the Allow 

Anonymous field. 

Disable: Select the Disable check box in the Allow 

Anonymous field. 

Enable or disable 

anonymous FTP 

upload 

Enable: Select the Enable check box in the Allow 

Anonymous Upload field. 

Disable: Select the Disable check box in the Allow 

Anonymous Upload field. 

Change the FTP 

directory path 

Enter a new path in the Change FTP default download 

directory field, and then press the Setting button. 
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Users and Password tab 

 

 

This tab provides functions to maintain the FTP accounts. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Maintain the FTP 

accounts 

Refer to the Appendix C.1 How to add a user account to 

remote login the ViewPAC from PC. 
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System Information Tab 

 

 

The System Information tab provides functions to monitor necessary system information 

of the ViewPAC-8000. The system information is the most important note of version 

control for upgrading system. 
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Auto Execution Tab 

 

 

The Auto Execute tab provides functions to configure programs running at 

ViewPAC-8000 startup, it allows users to configure ten execute files at most. 

 

The allowed file types are .exe and .bat, and they are executed in 

order of program 1, program 2, etc. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Configure programs 

running at startup 

Press the Browse button to select the execute file 

which you want, and then press the Setting button. 
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Multi-Serial Port Wizard Tab 

 

 

The Multi-serial port provides functions for installation of the 

RS-232/RS-422/RS-485 communication module driver. 

 

The table below shows the expansion 

RS-232/RS-422/RS-485 communication modules 

that are compatible with the ViewPAC. 

 

Item RS-232 RS-422/RS-485 Isolation Connector 

I-8112iW 2 - 2500 Vrms DB-9 x 2 

I-8114W 4 - - DB-37 x 1 

I-8114iW 4 - 2500 Vrms DB-37 x 1 

I-8142iW - 2 2500 Vrms Terminator block x 1 

I-8144iW - 4 2500 Vrms Terminator block x 1 

 

The ViewPAC can be expanded to support up to 16 I/O modules. 
 

For more detailed information about these support modules, please refer to 

http://www.icpdas.com/products/Remote_IO/i-8ke/selection_rs232_i8k.htm 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

http://www.icpdas.com/products/Remote_IO/i-8ke/selection_rs232_i8k.htm
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Key Property Tab 

 

 

The Key Property tab provides functions to specify the programmable key to launch any 

program that you wish. 

 

The allowed file types are .exe and .bat. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Specify the 

programmable key to 

launch the program 

Press the … button to select the execute file which 

you want, select the Enable check box, and then 

press the Setting button. 

Specify the 

programmable key to 

control backlight 

Select the F6 control backlight check box, and 

then press the Setting button. 
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System Memory Tab 

 

 

The SRAM Setting tab provides functions to adjust and monitor the unused RAM.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Adjust display Move the slider left to release more memory running 

programs or move the slider right to release more 

storage room, and then press the Setting button 
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4. Your First ViewPAC Program 

This chapter describes the components of the ViewPAC SDK, and provides step by step 

tutorial for developer that will teach you how to create your first ViewPAC program. 

 

Before writing your first program, ensure that you have the necessary development tools 

and the corresponding ViewPAC SDKs are installed on your system. 
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4.1. Preparing the Development Tools 

There are several programming tools available for application developers targeting 

Windows CE-based ViewPAC. One of the following tools must be installed on the Host 

PC. 
 

 Microsoft eMbedded Visual C++ 

 Visual Basic.net  

 Visual C# 
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4.2. Installing ViewPAC SDKs 

The ViewPAC SDK is a Software Development Kit (SDK) that contains C header files, C 

libraries and documents. 

Below is a step by step procedure for installing the ViewPAC SDKs. 

 

Step 1: Insert the CD into your CD-ROM drive 
 

Step 2: Execute the “PAC270_SDK_YYYYMMDD.msi” which is located in 

CD:\Napdos\wp-8x4x_ce50\SDK\ 
 

Step 3: Follow the prompts until the installation is complete 
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4.3. Understanding the ViewPAC APIs 

The ViewPAC SDKs includes several application programming interfaces (APIs) that 

allows you perform various supporting tasks when developing ViewPAC. 

 

 

 Requirements 

The ViewPAC SDK only supports NET Framework 2.0 or above. 

 

 Installation Path 

After installing the ViewPAC SDKs, a number of functions can be installed on the Host 

PC, and this installation puts the header files, libraries into the following public places so 

they are easily changed by update the ViewPAC SDKs. 

 

Header files: 

C:\Program Files\Windows CE Tools\wce500\PAC270\Icpdas\Include\ARMV4I\ 

 

Libraries: 

C:\Program Files\Windows CE Tools\wce500\PAC270\Icpdas\Lib\ARMV4I\ 
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4.3.1. ViewPAC SDK Overview 

4.3.1.1. WinPAC Standard API 

 

 

 

 

 

 

  

System Operation 

 System Information 

 Backplane Access 

 Interrupt 

 Memory Access 

PAC_IO 

Remote I/O Local I/O 

 Watchdog 

 UART 

 Registry 

 Micro SD 
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 SystemInformation Functions 

Provides reference information for the system status. 

 

 Backplane Access API 

Provides reference information for the backplane access APIs, including Hot Plug and 

backplane information.  

 

 Interrupt API 

Provides reference information for the Interrupt APIs  

 

 Memory Access API 

Provides reference information for the memory R/W APIs, including EEPROM and 

SRAM.  

 

 Watchdog Functions 

Provides reference information for the watchdog APIs, including hardware watchdog and 

OS watchdog. 

 

 UART API 

Provides reference information for the UART APIs. 

 

 Registry API 

Provides reference information for the registry.  

 

 microSD Management API 

Provides reference information for the microSD Manager. 

 

 PAC_IO API 

Provides reference information for IO APIs, including local and remote. 

In additions, no matter 8K or 87K modules use the same API. 

 

 Error Handling API 

Provides reference information for error handling. 
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4.3.1.2. ViewPAC Particular API 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Backlight Functions 

Provides reference information for the backlight. 

 

 Buzzer Beep Functions 

Provides reference information for the buzzer. 

 

 LED Functions 

Provides reference information for the LED  

 

 

 Backlight 

 Buzzer Beep 

 LED 
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4.3.2. ViewPAC SDK Reference 

For full usage information regarding the description, prototype and the arguments of 

the functions, please refer to the “WinPAC Standard API Manual” and “ViewPAC 

Particular API Manual” located at: 

CD:\Napdos\vp-2000_ce50\Document\SDK_Document\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/document/sdk_document/ 

 

 WinPAC Standard API Manual 

 

 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/document/sdk_document/
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 ViewPAC Particular API Manual 
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4.4. Your First Program in C# 

To create a demo program with C# development tool includes the following main steps: 
 

1. Create a new project 

2. Add project reference for an application 

3. Design and Build an application program 

4. Execute the application on the ViewPAC 
 

All main steps will be described in the following subsection. 
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4.4.1. Create a new project 

 

Step 1: Start the Visual Studio 2005 

 

Step 2: On the “File” menu, select the “New” command, and then click the 

“Project” command 

 

 

Step 3: In the “New Project” dialog box do the following in this order 
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Step 4: Click OK to start creating a “SDKinfo” project 
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4.4.2. Add project reference for an application 

 

Step 1: On the “Solution Explorer” window, right-click the “Reference” and 

then click the “Add Reference…” command 

 

 

 

Step 2: In the “Add Reference” 

dialog box, select the 

“Browse” tab, and then 

specify the directory of the 

“ViewPacNet.dll” file in the 

“File name” field 

 

 

The “ViewPACnet.dll” file can be obtained from: 

CD:\Napdos\vp-2000_ce50\SDK\ViewPACNet\ 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/sdk/ViewPACnet/ 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/sdk/viewpacnet/
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4.4.3. Design and Build an application program 

 

Step 1: Add a “button” object in the “From1” dialog box 

 

Step 2: Right-click the “button” object and click the “Properties” command 
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Step 3: On the “Properties” window, type “Check the SDK version” in the “Text” 

edit box 

 

 

 

Step 4: Right-click the “Form1” dialog box and click the “View Code” command 

to open the editor window 
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Step 5: Insert the “using ViewPACNet;” into the header area after “using 

System.Windows.Forms;” 

 

 

Step 6: In the “Form1” dialog box, double-click the “button” object to open the 

editor window 
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Step 7: Insert the following code in the Editor Window 

 

MessageBox.Show(pac_GetVIEWSDKVersion()); 
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4.4.4. Execute the application on the ViewPAC 

 

Step 1: On the “Build” menu, click the “Build Solution” command 

 

 

Step 2: Open the web browser and type the IP address to connect the FTP 

server of ViewPAC 

 

Step 3: Upload the “SDKinfo.exe” application and the corresponding 

“ViewPacNet.dll” file to the ViewPAC via the ViewPAC FTP server 
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Tips & Warnings 

For applications programming in C# and VB.net with .net 

framework, when executing these application on the ViewPAC 

controller, the corresponding “ViewPACnet.dll” file must be in the 

same directory as the .exe file 

 

 

 

Step 4: On the ViewPAC, execute the uploaded file 
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4.5. Your First Program in VB.net 

To create a demo program with C# development tool includes the following main steps: 
 

1. Create a new project 

2. Add project reference for an application 

3. Design and Build an application program 

4. Execute the application on the ViewPAC 
 

All main steps will be described in the following subsection. 
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4.5.1. Create a new project 

 

Step 1: Start the Visual Studio 2005 

 

Step 2: On the “File” menu, select the “New” command, and then click the 

“Project” command 

 

Step 3: In the “New Project” dialog box do the following in this order 
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Step 4: Click OK to start creating a “SDKinfo” project 
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4.5.2. Add project reference for an application 

 

Step 1: On the “Class View” window, right-click the “Reference” and then click 

the “Add Reference…” command 

 

 

 

Step 2: In the “Add Reference” dialog box, 

select the “Browse” tab, and then 

specify the directory of the 

“ViewPACNet.dll” file in the “File 

name” field 

 

 

 

The “Winpacnet.dll” file can be obtained from: 

CD:\Napdos\vp-2000_ce50\SDK\ViewPACNet\ 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/sdk/ViewPACnet/ 

 

 

 

  

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/sdk/viewpacnet/
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4.5.3. Design and Build an application program 

 

Step 1: Add a “button” object in the “From1” dialog box 

 

Step 2: Right-click the “button” object and click the “Properties” command 
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Step 3: On the “Properties” window, type “Check the SDK version” in the “Text” 

edit box 

 

 

 

Step 4: In the “Form1” dialog box, double-click the “button” object to open the 

editor window 
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Step 5: Insert the following code in the Editor Window 

 

1. Imports ViewPacNet 

2. MessageBox(ViewPACNet.pac_GetOSVersion()) 

 

 

 

  

1 

2 
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4.5.4. Execute the application on the ViewPAC 

 

Step 1: On the “Build” menu, click the “Build Solution” command 

 

 

Step 2: Open the web browser and type the IP address to connect the FTP 

server of ViewPAC 

 

Step 3: Upload the “SDKinfo.exe” application and the corresponding 

“ViewPacNet.dll” file to the ViewPAC via the ViewPAC FTP server 
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Tips & Warnings 

For applications programming in C# and VB.net with .net 

framework, when executing these application on the ViewPAC 

controller, the corresponding “ViewPACnet.dll” file must be in the 

same directory as the .exe file 

 

 

 

Step 4: On the ViewPAC, execute the uploaded file 
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4.6. Your First Program in eMbedded Visual C++ 

To create a demo program with eMbedded Visual C++ development tool includes the 

following main steps: 
 

1. Create a new Forms-Based project 

2. Configure compiler options 

3. Design and Build an application program 

4. Execute the application on the ViewPAC 
 

All main steps will be described in the following subsection. 
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4.6.1. Create a new Forms-Based project 

Step 1: Start the Microsoft Embedded Visual C++ 

 

Step 2: From the “File” menu, click the “New” command 
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Step 3: In the “New” dialog, select the “Projects” tab and do the following in 

this order 
 

 

Tips & Warnings 

The selected CPU type must have “Win32 [WCE ARMV4I]” 

 

 

Step 4: Click the “OK” button to start the wizard 
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Step 5: On the first page of the wizard, select “Dialog based” option and then 

click the “Next” button to the next step 

 

 

Step 6: On the next page of the wizard, leave all the options as they are, and 

then click the “Next” button to the next step 
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Step 7: On the next page of the wizard, leave all the options as they are, and 

then click the “Next” button to the next step 

 

 

 

Step 8: On the next page of the wizard, leave all the options as they are, and 

then click the “Finish” button to complete the wizard 
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Step 9: The final summary appears, click the “OK” button to exit the wizard 
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4.6.2. Configure compiler options 

 

On the WCE configuration toolbar, select the “Win32 [WCE ARMV4] Release” 
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4.6.3. Specify the path for project reference 

 

Step 1: Click the “Options…” command from the “Tools” menu 
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Step 2: In the “Option” dialog, select the “Directories” tab and do the following 

in this order to specify the header file include path  
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The “Viewpacsdk.h” file can be obtained from: 

CD:\Napdos\vp-2000_ce50\SDK\ViewpacSDK\ 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/sdk/viewpacsdk/ 

 

  

Click this button 

to specify the 

header file 

include path 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/sdk/viewpacsdk/
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Step 3: In the “Option” dialog, select the “Directories” tab and do the following 

in this order to specify the library file path  
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The “ViewPACSDK.lib” file can be obtained from: 

CD:\Napdos\vp-2000_ce50\SDK\ViewpacSDK\ 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/sdk/viewpacsdk/ 

 

 

  

Click this button 

to specify the 

library file path 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/sdk/viewpacsdk/
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Step 4: Click the “Settings…” command from the “Project” menu 

 

 

Step 5: In the “Project Settings” dialog box do the following in this order 
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4.6.4. Design and Build an application program 

Step 1: On the “Workspace” window, select the “ResourceView” tab and 

expand the “dialog” folder, and then double-click the 

“IDD_DEMO_DIALOG” to open the dialog box 

 

 

Step 2: Add the “button” object in the “SDKinfo” dialog box 
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Step 3: In the “SDKinfo” dialog box, right-click the button object and then click 

the “Properties” command 

 

 

Step 4: Type the “Check the SDK version” in the “Caption” edit box and then 

click the “close” button 
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Step 5: In the “SDKinfo” dialog box, double-Click the button object 

 

 

 

Step 6: Type the “OnBtnCheckSDK” in the “Member function name” edit box 

and then click the “OK” button 
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Step 7: Insert the following code into the Editor Window 
 

char SDK[32]; 

TCHAR buf[32]; 

pac_GetVIEWSDKVersion(SDK); 

pac_AnsiToWideString(SDK, buf); 

MessageBox(buf,NULL,MB_OK); 

 

 

 

Step 8: Insert the “#include “Viewpacsdk.h” and #include “winpacsdk.h”” into 

the header area 
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4.6.5. Execute the application program on 

ViewPAC 

Step 1: On the “Build” menu, click the “Build systeminfo.exe” command 

 

 

Step 2: Open the web browser and type the IP address to connect the FTP 

server of ViewPAC 

 

Step 3: Upload the “SDKinfo.exe” application to the ViewPAC via the ViewPAC 

FTP server 

 

Step 4: On the ViewPAC, execute the 

uploaded file 
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5. APIs and Demo References 

This chapter introduces demo programs that have been designed for the ViewPAC. You 

can examine the demo source code, which includes numerous comments, to familiarize 

yourself with the ViewPAC API. This will allow developing your own applications quickly 

by modifying these demo programs. The following details the contents of the ViewPAC 

demo programs. 
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5.1. Demo programs with C# 

The table below describes the ViewPAC demos that have been designed to 

demonstrate the standard operation features of the ViewPAC. 
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5.1.1. C# Demo program for WinPAC Standard API 

The table below describes the ViewPAC demos that have been designed to 

demonstrate the standard operation features of the ViewPAC. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Folder Demo Explanation 

system systeminfo 

Retrieves information about the OS 

version, CPU version, SDK version, 

etc. 

System Operation 

 System Information 

 Backplane Access 

 Interrupt 

 Memory Access 

 Watchdog 

 UART 

 Registry 

 Micro SD 



 

VP-23W1/VP-25W1 User Manual, version 1.0.7.   Last Revised: March 2012   Page: 114 

Copyright ©  2012 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 

 

 

Folder Demo Explanation 

backplane backplaneinfo 
Retrieves information about the DIP 

switch, backplane ID and slot count. 

memoryaccess 

memory 
Shows how to read/write date values 

from/to EEPROM 

battery_backup_sram 
Shows how to read or write to the 

battery backup 

watchdog watchdog Displays how the watchdog operate 

microsd microsd_management 
Shows how to enables/disables 

Micro SD 

registry registry 
Shows how to read/write date values 

from/to registry 

UART diag 
Shows how to read the name of 

local I/O modules via UART 

 

For C# application, these demo programs can be obtained from: 

CD:\Napdos\wp-8x4x_ce50\Demo\WinPAC\DotNET\C#.NET\Standard\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/dotnet/c%23.

net/standard/ 

 

  

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/dotnet/c%23.net/standard/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/dotnet/c%23.net/standard/
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5.1.2. C# Demo program for PAC IO API 

The table below describes the ViewPAC demos that have been designed to 

demonstrate the expansion I/O module features of the ViewPAC. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Folder Demo Explanation 

Local find_io 
Shows how to retrieve the module names and types 

which plugged in the ViewPAC. 

PAC_IO 

Remote I/O Local I/O 
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Folder Demo Explanation 

8k_di 
Shows how to read the DI values of DI module. 

This demo program is used by 8K series DI modules. 

8k_do 
Shows how to write the DO values to DO module. 

This demo program is used by 8K series DO modules. 

8k_dio 

Shows how to read the DI and the DO values of the 

DIO module.  

This demo program is used by 8K series DIO 

modules. 

87k_basic 

Shows how to send/receive a command/response 

application. 

This demo program is used by 87K series modules. 

87K_demo 

Shows how use UART API and the IO modules 

located as slots.  

This demo program is used by 87K series modules. 

87k_ai 
Shows how to read the AI values of AI module. 

This demo program is used by 87K series AI modules. 

87k_ao 

Shows how to write the AO values to AO module. 

This demo program is used by 87K series AO 

modules. 

87k_di 
Shows how to read the DI values of DI module. 

This demo program is used by 87K series DI modules. 

87k_do 

Shows how to write the DO values to DO module. 

This demo program is used by 87K series DO 

modules. 

87k_dio 

Shows how to read the DI and the DO values of the  

DIO module. 

This demo program is used by 87K series DIO 

modules. 

Remote 

7k87k_basic 

Shows how to send/receive a command/response 

application. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_ai 

Shows how to read the AI values of AI module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_ao 
Shows how to write the AO values to AO module. 

This demo program is used by 7K or 87K series  
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Folder Demo Explanation 

AI modules which connected through a COM port. 

7k87k_di 

Shows how to read the DI values of DI module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_do 

Shows how to write the DO values to DO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_dio 

Shows how to read the DI and the DO values of the 

DIO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

 

For C# application, these demo programs can be obtained from: 

CD:\Napdos\wp-8x4x_ce50\Demo\WinPAC\DotNET\C#.NET\PAC_IO\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/dotnet/c%23.

net/pac_io/ 

 

  

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/dotnet/c%23.net/pac_io/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/dotnet/c%23.net/pac_io/
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5.1.3. C# Demo program for ViewPAC Particular API 

The table below describes the ViewPAC demos that have been designed to 

demonstrate the particular features of the ViewPAC. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Folder Demo Explanation 

BuzzerBeep BuzzerBeep 
Shows how to make a simple buzzer 

beep. 

KeyPad KeyPad Shows how the KeyPad operates. 

LCDBackLight LCDBackLight 
Shows how to control the LCD 

backlight. 

Led Led Shows how to control the LEDs. 

PlaySound PlaySound 
Shows how to control the 

microphone-in and earphone-out. 

 

For C# application, these demo programs can be obtained from: 

CD:\Napdos\vp-2000_ce50\Demo\ViewPAC\DotNET\C#.NET\ 

 Backlight 

 Buzzer Beep 

 LED 
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ftp://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/demo/viewpac/dotnet/c%2

3.net/ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/demo/viewpac/dotnet/c%23.net/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/demo/viewpac/dotnet/c%23.net/
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5.2. Demo Programs with eMbedded Visual C++ 

Examples are good way to understand the ViewPAC SDK. The table below describes 

ViewPAC demos and covers most of the common usages of each ViewPAC API for 

using eMbedded Visual C++. 
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5.2.1. eVC Demo program for WinPAC Standard API 

The table below describes the ViewPAC demos that have been designed to 

demonstrate the standard operation features of the ViewPAC. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Folder Demo Explanation 

system systeminfo 

Retrieves information about the OS 

version, CPU version, SDK version, 

etc. 

backplane backplaneinfo Retrieves information about the DIP 

System Operation 

 System Information 

 Backplane Access 

 Interrupt 

 Memory Access 

 Watchdog 

 UART 

 Registry 

 Micro SD 
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Folder Demo Explanation 

switch, backplane ID and slot count. 

memoryaccess 

memory 
Shows how to read/write date values 

from/to EEPROM 

battery_backup_sram 
Shows how to read or write to the 

battery backup 

watchdog watchdog Displays how the watchdog operate 

microsd microsd_management 
Shows how to enables/disables 

Micro SD 

registry registry 
Shows how to read/write date values 

from/to registry 

UART diag 
Shows how to read the name of 

local I/O modules via UART 

 

For C# application, these demo programs can be obtained from: 

CD:\Napdos\wp-8x4x_ce50\Demo\WinPAC\DotNET\C#.NET\Standard\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/dotnet/c%23.

net/standard/ 

  

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/dotnet/c%23.net/standard/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/dotnet/c%23.net/standard/
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5.2.2. eVC Demo program for PAC IO API 

The table below describes the ViewPAC demos that have been designed to 

demonstrate the expansion I/O module features of the ViewPAC. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 
 

Folder Demo Explanation 

Local 

find_io 
Shows how to retrieve the module names and types 

which plugged in the ViewPAC. 

8k_di 
Shows how to read the DI values of DI module. 

This demo program is used by 8K series DI modules. 

PAC_IO 

Remote I/O Local I/O 
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Folder Demo Explanation 

8k_do 
Shows how to write the DO values to DO module. 

This demo program is used by 8K series DO modules. 

8k_dio 

Shows how to read the DI and the DO values of the 

DIO module.  

This demo program is used by 8K series DIO 

modules. 

87k_basic 

Shows how to send/receive a command/response 

application. 

This demo program is used by 87K series modules. 

87K_demo 

Shows how use UART API and the IO modules 

located as slots.  

This demo program is used by 87K series modules. 

87k_ai 
Shows how to read the AI values of AI module. 

This demo program is used by 87K series AI modules. 

87k_ao 

Shows how to write the AO values to AO module. 

This demo program is used by 87K series AO 

modules. 

87k_di 
Shows how to read the DI values of DI module. 

This demo program is used by 87K series DI modules. 

87k_do 

Shows how to write the DO values to DO module. 

This demo program is used by 87K series DO 

modules. 

87k_dio 

Shows how to read the DI and the DO values of the  

DIO module. 

This demo program is used by 87K series DIO 

modules. 

Remote 

7k87k_basic 

Shows how to send/receive a command/response 

application. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_ai 

Shows how to read the AI values of AI module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_ao 

Shows how to write the AO values to AO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_di Shows how to read the DI values of DI module. 
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Folder Demo Explanation 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_do 

Shows how to write the DO values to DO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_dio 

Shows how to read the DI and the DO values of the 

DIO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

 

For C# application, these demo programs can be obtained from: 

CD:\Napdos\wp-8x4x_ce50\Demo\WinPAC\DotNET\C#.NET\PAC_IO\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/dotnet/c%23.

net/pac_io/ 

 

  

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/dotnet/c%23.net/pac_io/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/dotnet/c%23.net/pac_io/
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5.2.3. eVC Demo program for ViewPAC Particular API 

The table below describes the ViewPAC demos that have been designed to 

demonstrate the particular features of the ViewPAC. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Folder Demo Explanation 

BuzzerBeep BuzzerBeep 
Shows how to make a simple buzzer 

beep. 

KeyPad KeyPad Shows how the KeyPad operate. 

LCDBackLight LCDBackLight 
Shows how to control the LCD 

backlight. 

Led Led Shows how to control the LEDs. 

PlaySound PlaySound 
Shows how to control the 

microphone-in and earphone-out. 

 

For C# application, these demo programs can be obtained from: 

CD:\Napdos\vp-2000_ce50\Demo\ViewPAC\DotNET\C#.NET\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/demo/viewpac/dotnet/c%2

3.net/ 

 Backlight 

 Buzzer Beep 

 LED 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/demo/viewpac/dotnet/c%23.net/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/demo/viewpac/dotnet/c%23.net/
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6. ViewPAC Updates 

This chapter provides instructions on how to upgrade ViewPAC OS and SDK. 

 

ICP DAS will continue to add additional features to ViewPAC SDK and OS in the future, 

so we advise you to periodically check the ICP DAS web site for the latest updates. 

 

ViewPAC updates services can be divided into the following two main categories: 

 

 

 

 

 

  

CD: \Napdos 

vp-2000_ce50 

os_image 

vp-23w1 

vp-25w1 

SDK 

viewpacnet 

viewpacsdk 

1. OS updates 

2. SDK updates 
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6.1. OS updates 

The updates files of OS image are located on: 
 

VP-23W1: 

CD:\Napdos\vp-2000_ce50\OS_image\vp-23w1\ 
 

VP-25W1: 

CD:\Napdos\vp-2000_ce50\OS_image\vp-25w1\ 

 

 

 

  

CD: \Napdos 

vp-2000_ce50 

OS_image 

vp-23w1 

eboot 

update_from_eshell 

update_from_file 

vp-25w1 

eboot 

update_from_eshell 

update_from_file 
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There are two different ways of ViewPAC OS image updates: 
 

i. ViewPAC OS updates from file 

(We recommend that you use this method for quick and easy to update ViewPAC OS 

image) 
 

 

ii. ViewPAC OS updates from eshell 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The ViewPAC OS supports multi-language: 
 

i. en- English 

ii. sc- Simplified Chinese 

iii. tc- Traditional Chinese 

 

os_image 

vp-23w1/vp-25w1 

update_from_file 

en sc tc 

update_from_eshell 

en sc tc 

OS_image 

VP-23w1/vp/25w1 

Update_from_files Update_from_eshell 

 SDK update 
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6.1.1. Updating the Boot Loader and the ViewPAC OS image from files 

There are two different ways of ViewPAC OS image update: 
 

i. ViewPAC OS updates from files (Please refer to this section) 

We recommend that you use this method for quick and easy to update the 

ViewPAC OS image 
 

ii. ViewPAC OS updates from eshell tool (Please refer to section “6.1.2. Updating 

the ViewPAC OS image from eshell”) 

 

 

 

 

 

 
 
 
 
 
 
 

 

 

Step 1: Get the latest version of the execute file and the corresponding 

“autoinit.bat” file and run it on the ViewPAC side 
 

Each folder contains an execute file and a corresponding “autoinit.bat” file. 

 

  

OS_image 

vp-23w1/vp-25w1 

Update_from_files Update_from_eshell 
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Step 2: Get the latest version of the installation package and download it to 

ViewPAC, then execute it 

 

For VP23W1: 
 

The latest version of the installation package can be obtained from:  

CD:\Napdos\vp-2000_ce50\os_image\vp-23w1\update_from_file\ 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/os_image/vp-23w1/updat

e_from_file/ 
 

 
 

For VP25W1: 
 

The latest version of the installation package can be obtained from:  

CD:\Napdos\vp-2000_ce50\os_image\vp-25w1\update_from_file\ 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/os_image/vp-25w1/updat

e_from_file/ 

 

 

 

 

 

 

 

 

 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/os_image/vp-23w1/update_from_file/
http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/os_image/vp-23w1/update_from_file/
http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/os_image/vp-25w1/update_from_file/
http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/os_image/vp-25w1/update_from_file/
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There are several ways to download the installation package to ViewPAC: 
 

On the ViewPAC, you can download the installation package via an Ethernet 

connection. 
 

On the host PC, you can download the installation package to ViewPAC via a USB 

storage device, the removable Micro SD card or FTP server. 

 

The latest version of the ViewPAC OS image file can be obtained from: 

CD:\Napdos\wp-8x4x_ce50\OS_image\update_from_file\  

http://www.icpdas.com/products/PAC/ViewPAC/download/ViewPAC_8000/download

_os_images.htm 

 

Step 3: After execute the installation package, the “Warning !” dialog will 

display, then click the “OK” button to start the update instructions 

 

Step 4: On the main dialog, click the “Update Now” button 

 

http://www.icpdas.com/products/PAC/winpac/download/winpac_8000/download_os_images.htm
http://www.icpdas.com/products/PAC/winpac/download/winpac_8000/download_os_images.htm
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Step 5: On the “Warning !” dialog, click the “Yes” button 

 

 

Step 6: On the main dialog, click the “Update Now” button to start installation 

 

Tips & Warnings 

Please never turn the ViewPAC off during OS load. Besides we 

recommend you turn off all other application before updating. 
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The installation will perform the following tasks: 

 

 

 

 

 

 

 
 

 

 

 

 

 

i. Install Boot Loader file 

 

Important Warning 

Be careful, if the boot loader broken off in this step and cannot 

restart in safe mode, you have to send it back to us. 

 

ii. Erase flash disk 
 

iii. Install OS image 
 

iv. Set registry settings to default 

Tips & Warnings 

This step will reset the registry settings to default, all of your 

before settings will lost. 
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Step 7: After completing the above-mentioned tasks, the “Warning !” dialog will 

appear as follow, after clicking “OK” button to finish updating OS 

image, be sure the ViewPAC at normal mode 

 

 

 

 

 

Step 8: Check the View PAC OS version 
 

Start the WinPAC Utility, and then select the “System Information” tab to check the 

current OS version. 
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6.1.2. Updating the ViewPAC OS image from 

eshell 

There are two different ways of ViewPAC OS image update: 
 

i. ViewPAC OS updates from files (Please refer to this section) 

We recommend that you use this method for quick and easy to update the 

ViewPAC OS image 
 

ii. ViewPAC OS updates from eshell tool (Please refer to section “6.1.2. Updating 

the ViewPAC OS image from eshell”) 

 

 

 

 

 

 

 

 

 

 

 

 

By default, the OS update from Host PC to 

ViewPAC via Ethernet. Therefore, to update the 

OS image, make sure Ethernet is connected to 

the PC. 

 

 

UUUpppgggrrraaadddeee   

OS_image 

vp-23w1/vp-25w1 

Update_from_files Update_from_eshell 
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Step 1: Get the latest version of the ViewPAC OS image 

 

For VP23W1: 
 

The latest version of the installation package can be obtained from:  

CD:\Napdos\vp-2000_ce50\os_image\vp-23w1\update_from_Eshell\ 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/os_image/vp-23w1/updat

e_from_Eshell/ 

 
 

For VP25W1: 
 

The latest version of the installation package can be obtained from:  

CD:\Napdos\vp-2000_ce50\os_image\vp-25w1\update_from_Eshell\ 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/os_image/vp-25w1/updat

e_from_Eshell/ 

 

 

 

 

 

 

 

 

 

 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/os_image/vp-23w1/update_from_Eshell/
http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/os_image/vp-23w1/update_from_Eshell/
http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/os_image/vp-25w1/update_from_Eshell/
http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/os_image/vp-25w1/update_from_Eshell/
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Step 2: Run the ESHELL software on the Host PC 

 

ESHELL you can be obtained at: 
 

CD:\Napdos\wp-8x4x_ce50\PC_Tools\Eshell\ 

ftp://ftp.icpdas.com/pub/cd/ViewPAC/napdos/wp-8x4x_ce50/pc_tools/eshell/ 

 

Step 3: Reboot the ViewPAC at update OS mode 
 

Turn the rotary switch to “3”, and then reboot the ViewPAC. 

  

ftp://ftp.icpdas.com/pub/cd/ViewPAC/napdos/wp-8x4x_ce50/pc_tools/eshell/
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Step 4: Select the device which you want to update the OS image 
 

After starting the ESHELL software, the “Select Device” dialog will appear, then select 

the device which you want. 

 

 

Step 5: Select the latest version of the OS image 
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Step 6: Once the procedure is completed, the “Warning !” dialog box will 

Appear on ViewPAC screen as below shown, before clicking the “Yes” 

button, you must first turn the rotary switch to the “0” position 

 

 

 

Step 7: Check the ViewPAC OS version 
 

Start the WinPAC Utility, and then select the “System Information” tab to check the 

current OS version. 
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6.2. SDKs Updates 

The updates files of SDK image are located on: 
 

CD:\Napdos\vp-2000_ce50\SDK\ 

 

 

 

 

 

By eVC and donet development tools, the ViewPAC SDK installation is divided into the 

following two parts: 
 

 

By eVC and donet development tools, the WinPAC SDK installation is divided into the 

following two parts: 
 

i. WinPAC SDK updates for dotnet 

ii. WinPAC SDK updates for eMbedded Visual C++ 

 

 

  

CD: \Napdos 

vp-2000_ce50 

SDK 

viewpacnet 

viewpacsdk 
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6.2.1. WinPAC SDK updates for C# or VB.net 

To determine the SDK version that is compatibly running on the WinPAC, you can 

read the “Release Note” which is located under each SDK folder, these files provides 

important updated information for what we fixed and added. 

 

 

Step 1: Get the latest version of the C# or VB.net components 
 

The latest version of the C# or VB.net components can be obtained from:  

ftp://ftp.icpdas.com/pub/cd/WinPAC/napdos/wp-8x4x_ce50/sdk/WinPACNet/ 

 

Step 2: Copy the latest version of DLL to Host PC and WinPAC 
 

The DLL files on Host PC are located at anywhere only the solution can reference it. 

The DLL files on WinPAC are located at the same directory as the .exe file. 

 

 

  

ftp://ftp.icpdas.com/pub/cd/ViewPAC/napdos/vp-2000_ce50/sdk/ViewPacNet/
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6.2.2. WinPAC SDK updates for eMbedded Visual 

C++ 

To determine the SDK version that is compatibly running on the WinPAC, you can 

read the “Release Note” which is located under each SDK folder, these files provides 

important updated information for what we fixed and added. 

 

 

Step 1: Get the latest version of the eMbedded Visual C++ components 
 

The latest version of the eMbedded Visual C++ components can be obtained from:  

ftp://ftp.icpdas.com/pub/cd/WinPAC/napdos/wp-8x4x_ce50/sdk/WinPACSDK/ 

 

 

Step 2: Copy the latest version of header files and libraries to Host PC 
 

The header files are located at:  

C:\Program Files\Windows CE Tools\wce500\PAC270\Include 

The libraries are located at:  

C:\Program Files\Windows CE Tools\wce500\PAC270\Lib 

 

Step 3: Copy the latest version of DLL files to WinPAC 
 

The DLL files are located at:  

\System_Disk\ICPDAS\System  

 

  

ftp://ftp.icpdas.com/pub/cd/ViewPAC/napdos/vp-2000_ce50/sdk/ViewpacSDK/
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7. ViewPAC Download Center 

This chapter introduces the WinPAC-8000 Download Center. 
 

Visit the ViewPAC Download Center: 

http://www.icpdas.com/products/PAC/viewpac/download/viewpac/download_os_images.

htm 

 

The following update categories are available from the ViewPAC Download Center. 
 

 OS images Includes updates and the latest version of ViewPAC OS. 
 

 ViewPAC SDK Includes updates and the latest version of each ViewPAC component 

SDK, such as ViewPAC SDK, NAPOPC_CE5 SDK, Modbus SDK, etc. 
 

 Utility & Tools Includes updates and the latest version for ViewPAC toolkits 
 

 Demo Includes all related ViewPAC demos. 
 

 Documents Includes updates and the latest version for related ViewPAC documents. 
 

 System Disk Includes updates and the latest version for ViewPAC toolkits  

http://www.icpdas.com/products/PAC/viewpac/download/viewpac/download_os_images.htm
http://www.icpdas.com/products/PAC/viewpac/download/viewpac/download_os_images.htm
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Appendix A. I-8K and I-87K Modules 

There are 3 slot options to expand local I/O. And the I/O modules can be parallel bus type 

(high profile I-8K series) and serial bus type (high profile I-87K series).  

 

The difference between them is 

 

Item I-8K Series I-87K Series 

Communication interface Parallel bus Serial bus 

Protocol - DCON 

Communication speed Fast Slow 

DI latched function - Yes 

Counter input (for digital input module) - Yes (100 Hz) 

Power on value - Yes 

Safe value - Yes 

Programmable slew-rate for AO module - Yes 
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Appendix B. Application of RS-485 Network 

The RS-485 length can be up to 4000 ft or 1.2 km over a single set of twisted–pair cables, 

if the RS-485 network is over 4000 ft or 1.2Km, the RS-485 repeater must be added to 

extend the RS-485 network. 
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B.1. Basic RS-485 Network 

The basic component of the RS-485 network consist of a Master Controller (or using a 

PC as a host controller), and some RS-485 devices. 

 

Tips & Warnings 

If PC/Laptop has no COM port, you can use the I-7561 (USB to RS-485 

converter) for connection between ViewPAC and PC/Laptop. 

Before using the I-7561 converter, you must install the USB driver. The 

USB driver can be obtained from: 

ftp://ftp.icpdas.com/pub/cd/8000cd/napdos/7000/756x/ 

 

 

 

  

ftp://ftp.icpdas.com/pub/cd/8000cd/napdos/7000/756x/
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B.2. Daisy Chain RS-485 Network 

All RS-485 devices are wired directly to the main network, If the network is up to 1.2 km, 

it will need a repeater (7510 series) to extend the network length. 
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B.3. Star Type RS-485 Network 

There are branches along the main network. In this case, it is better to have a repeater to 

isolate or filter the noise that is made by devices. 
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There is a better choice to use 7513 as a RS-485 hub on start type network. 
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B.4. Random RS-485 Network 

There are branches along the main wire. In this case, it is better to have a repeater to 

isolate or filter the noise that is made by devices. 
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B.5. Master/Slaves Settings 

There must be exist one master to have a jumper in the same network. In a master/slave 

application, “Master” is the default configuration of ViewPAC. 
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B.5.1. ViewPAC as a Master (default) 

When one of ViewPAC is set to the master mode, then all the other devices on the 

same network must be set to the slave mode. 

 

Set ViewPAC to the master mode by adjusting the jumpers on the power board of 

ViewPAC. Refer to the following figure: 
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B.5.2. ViewPAC as a Slave: 

Set ViewPAC to the slave mode by adjusting the jumpers on the power board of 

ViewPAC. Refer to the following figure: 
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The maximum distance of RS-485 without using a repeater is 1,200 meters (4,000 feet). 

You can extend that distance by adding an RS-485 Repeater every 1,200 meters as 

shown below. 
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Appendix C. Tips – How to 
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C.1. How to add a user account to remote login the ViewPAC from PC 
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C.2.1. How to add a user account 

Here are step by step instructions on how to add a user account. 

 

Step 1: Run the ViewPAC Utility 

 

Step 2: On the Network tab, click Login tab, 

type the User Name and Password, 

and then click Add button 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 3: The user has been added to the allowed under the remote login and 

included in the following list 
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Step 4: On the File menu, click Save and Reboot for changes to take effect 
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C.2.2. How to Use telnet to remote login the ViewPAC from PC 

Here are step by step instructions on how to use telnet to remote login the XPAC from 

PC. 

 

 

Step 1: On the PC, open a MS-DOS command prompt 

 

 

 

Step 2: At the command prompt, type “telnet (IP address)” 

 

 

 

 

 

 

 

 

 

 

 

 

1 

2. Type 

“cmd” 
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Step 3: The connection has been set up, and then type the name and password 

 

 

Step 4: The remote login has been completed 
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C.2.3. How to remove the user from the login list 

Here are step by step instructions on how to remote the user from the login list. 

 

 

Step 1: Click a user from the list which you want to remove, and the user will 

display in the field, and then press Delete to delete the user from the 

login list 
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Step 2: On the File menu, click Save and Reboot for changes to take effect 
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C.2. How to online debug ViewPAC 

Debugging is a process that you use to find and resolve errors, or bugs, in a program. 
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C.2.1. Debug ViewPAC programs in EVC++ 

Step 1: On the “Tools” menu, click “Configure Platform Manager…” command 
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Step 2: On the “Windows CE Platform Manager Configuration” dialog, click the 

“Properties…” button 

 

 

Step 3: On the “Device Properties” dialog, click the “Configure…” button 
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Step 4: On the “TCP/IP Transport Configuration” dialog, select the “Fixed port” 

check box, and then click the “OK” button 

 

 

Step 5: On the “Windows CE Platform Manager Configuration” dialog, click the 

“Test” button 
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Step 6: The “Manual Server - Action” dialog will appear displaying a command 

line, before click the “OK” button to close dialog, turn to the ViewPAC 

controller side to do the next two-steps 

 

 

Step 7: On the ViewPAC controller side, select the “ Start” menu, and 

then click the “Run…” command  
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Step 8: On the “Run” dialog, type the command which displays in step 5 and 

then click the “OK” button 

 

 

Step 9: Return to the Host PC side, on the “Manual Server – Action” dialog, 

click the “OK” button 
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Step 10: On the “Testing Device Connection” dialog, click the “OK” button 

 

 

Step 11: On the “Device Properties” dialog, click the “OK” button 
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Step 12: On the “Windows CE platform or device to configure” dialog, click the 

“OK” button 

 

 

Step 13: On the “Build” menu, select the “Start Debug” command and then 

click the “Go” command 
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Step 14: The “Manual Server - Action” dialog will appear displaying a command 

line, before click the “OK” button to close dialog, turn to the ViewPAC 

controller side to do the next two-steps  

 

 

Step 15: On the ViewPAC controller side, select the “ Start” menu, 

and then click the “Run…” command  
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Step 16: On the “Run” dialog, type the command which displays in step 5 and 

then click the “OK” button  

 

 

Step 17: Return to the Host PC side, on the “Manual Server – Action” dialog, 

click the “OK” button 
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Step 18: On the “Manual Server - Action” dialog, click the “OK” button 

 

 

Step 19: Connection established. Then you can debug on line. 

 

Tips & Warnings 

If you want to quit the debugger and return to editing, you can click 

the “Stop Debugging “button from “Debug” menu 
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C.2.2. Debug ViewPAC programs in Visual 

Studio 2005/2008 

Debugging in Visual Studio 2005/2008 are provided by ViewPAC OS image V 1.3.0.4 

or later. 

 

Step 1: Make sure the following file are listed with the matching version 

numbers 

 

Path File 

C:\Program Files\Common Files\Microsoft 

Shared\CoreCon\1.0\Bin 

1. ActiveSyncBootstrap.dll 

2. ConMan2.dll 

3. ConManPS.dll 

4. DesktopDMA.dll 

5. eDbgTL.dll 

6. TcpConnectionC.dll 

C:\Program Files\Common Files\Microsoft 

Shared\CoreCon\1.0\Bin\1033 

conmanui.dll 

C:\Program Files\Common Files\Microsoft 

Shared\CoreCon\1.0\Target\wce400\armv4i 

1. DeviceDMA.dll 

2. eDbgTL.dll 

3. TcpConnectionA.dll 

4. clientshutdown.exe 

5. CMAccept.exe 

6. ConmanClient2.exe 

 

Step 2: If the version matches correctly and the entire file are there, copy the 

following files to ViewPAC :\ System_Disk\ICPDAS\System folder 
 

 Clientshutdown.exe 

 ConmanClient2.exe 

 CMaccept.exe 

 eDbgTL.dll 

 TcpConnectionA.dll 
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Step 3: On the “Project” menu, click “[Project Name] Properties…” command 

 

 

Step 4: On the “SystemInfo*” tab, unselect “Deploy the latest version of 

the .NET compact Framework (includeing Service Packs)” check box 
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Step 5: On the “Tools” menu, click “Options…” command 

 

 

Step 6: On the “Options” dialog, select “PAC 270” from the “Show devices 

platform” list, and then click the “Properties…” button 
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Step 7: On the “CAYMAN-ARMV4I_Release Properties” dialog, click the 

“Configure…” button 

 

 

Step 8: On the “Configure TCP/IP Transport” dialog, select the “Use specific IP 

address” option and type the IP address of ViewPAC, and then click 

the “OK” button 
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Step 9: On the “CAYMAN-ARMV4I_Release Properties” dialog, click the “OK” 

button 

 

 

Step 10: On the “Options” dialog, click the “OK” button 
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Step 11: On the ViewPAC controller side, run the “CommanClient2” and the 

“CMAccept.exe” applications which is located at: 

\System_Disk\ICPDAS\System 

 

 

Step 12: On the “Tools” menu, click “Connect to Device…” command 
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Step 13: On the “Connect to Device” dialog, select “PAC 270” from “Platform” 

list and then click the “Connect” button 

 

 

Step 14: On the “Tools” menu, click “Connect to Device…” command 

 

 

Step 15: Connection established. Then you can debug on line. 
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FAQ: 

 

If the connection fails shown as follow, return to step 11 to do the action below 

 

 

Open the command prompt, run the 

“CommanClient2.exe/transport:tcpconnectiona.dll/property:port=5000/

id:Con” at: \System_Disk\ICPDAS\System, and then run the 

“CMAccept.exe” 
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C.3. How to recompile WinCon programs 

To recompile Wincon programs to run on ViewPAC, certain components of the programs 

require adjustments that divides into two parts: 
 

1. Compiler old programs which ran on Wincon 8x3x and 8x4x 

2. Modify .vcp file to upgrade the old WinCon project 

 

Tips & Warnings 

In general, you only need to do part 1, after this, if the program still 

can’t be compiled to an application, the part 2 just need to do. 
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C.3.1. Compiler old programs which ran on Wincon 8x3x and 8x4x 

Step 1: Open project which programmed in WinCon using eMbedded Visual 

C++ 

 

Step 2: On the “Build” menu, click “Configurations” command 

 

 

Step 3: Make sure the CPU type is “STANDARDSDK” 
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Step 4: On the “Configurations” dialog, click the “Add…” button 

 

 

Step 5: On the “Add Project Configuration” dialog, choose one of the CPU type 

and then click the “OK” button. 
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Step 6: On the “Project” menu, click “Settings…” command 

 

 

Step 7: On the “Project Settings” dialog, select the “Link” tab and change the 

value of the “Entry-point symbol” field, “WinMainCRTStarup” to 

“wWinMainCRTStartup”, 
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Step 8: After performing above-mentioned steps, build the project, your project 

should build success. If not, it will show error message as follow. 

Please continue with the following steps 

 

 

Step 9: On the “Project” menu, click “Settings…” command 

 

 

Step 10: On the “Project Settings” dialog, select the “Link” tab and change the 

value of the “Project Options” field, “ARM” to “THUMB”, and then built 

the project  
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C.3.2. Modify .vcp file to upgrade the old 

WinCon project 

Step 1: Open a text editor to modify the .vcp file  
 

Step 2: In the .vcp file, replace “0xa301” with “0xa501” 
 

Step 3: In the .vcp file, replace “ARMV4” with “ARMV4I” 
 

Step 4: In the .vcp file, replace “MACHINE:ARM” with “MACHINE:THUMB” 
 

Step 5: Save the .vcp file just edited 
 

Step 6: Open the old WinCon project and recompile it 
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C.4. How to use the printer 

ViewPAC have ability to access the printer, you can connect to the printer via Ethernet 

network or USB. 

 

Tips & Warnings 

ViewPAC only supports HP Laser Jet Printers which support 

PCL6 driver. 
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C.4.1. How to use network printer 

To use a shared network printer, please perform the following steps: 

 

Step 1: On the Host PC, check the name of the Host PC and the shared printer  

 

 

 

 

 

 

 

 

 

 

 

 



 

VP-23W1/VP-25W1 User Manual, version 1.0.7.   Last Revised: March 2012   Page: 194 

Copyright ©  2012 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 

 

 

Step 2: On the ViewPAC, open a WordPad format file 

 

Step 3: On the ViewPAC, open a WordPad format file 

 

 

 

Step 2: Set up the printer 

1. Printer: PCL Laser 

2. Port: Network 

3. Net Path: \\ServerName\PrinterName 

The “ServerName” is your PC’s name or IP. 

The “PrinterName” is your printer’s shared 

name of your PC 

4. Paper Size: Select the paper size 

 

 

 

file://ServerName/PrinterName
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C.4.2. How to use printer via USB 

To use a shared network printer via USB, please perform the following steps: 

 

Step 1: On the ViewPAC, open a WordPad format file 

 

 

 

 

Step 2: Set up the printer 

1. Printer: Hewlett-Packard LaserJet 

2. Port: LPT1 

3. Paper Size: Select the paper size 
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C.5. How to use services tool 

The services tool can help you turn on, turn off and monitor the WinCE services. 

 

Step 1: Open a MS-DOS command prompt 
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Step 2: List all services 
 

[Syntax] services list 

 

 

Step 3: Type the commands to configure service  
 

[Syntax] services stop <services name> 

For example, turn on the “FTP” service: 

services stop FTP0: 
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Tips & Warnings 

For more information about using services tool, you just type 

“services help” 
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Appendix D. Revision History 

 

Revision Date Description 

1.0.1 August 2009 Initial issue 

1.0.2 September 

2009 

Added information about the support of the printer 

driver in section C.4 

1.0.3 December 

2009 

1. Modified the operating modes in section 2.5 

2. Added the requirements of the ViewPAC SDK in 

section 4.3. 

1.0.4 February 2010 1. Modified the specification of the Dual Battery Backup 

SRAM features in section 1.1. 

2. Modified information about Operating Environment 

in section 1.2. 

1.0.5 January 2011 1. Added information on how to use Backup Utility to 

back up the settings and files in section 2.9. 

2. Added information about a caution of using 

System_Disk in section 2.10. 

3. Added information about the ViewPAC Utility 

functionality in section in section 3.5.2. 

4. Deleted information on how to establish a new telnet 

and FTP account in section C.1. 

5. Added information on how to add a user account to 

remote login the ViewPAC from PC in section C.1. 

1.0.6 July 2011 1. Added information on the Overview in section 1.4. 

2. Modified information about the application of RS-485 

network in appendix E. 
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